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in diesem Buch beruhen auf der persönlichen Erfahrung, Recherche und Einschätzung des Autors und sind frei von 
Herstellerinteressen gehalten. Trotz sorgfältiger Ausarbeitung und der langjährigen Expertise des Autors mit dem 
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Um Kosten bei der Erstellung dieses Buchs niedrig zu halten, wurde auf den Einsatz eines professionellen Lek-
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Warum dieses Buch?
Möchte man sich auf eigene Faust über den Einsatz von Empower 3 informieren, werden einem viele 

Quellen angeboten. Der Hersteller selbst stellt bereits zahlreiche Anleitungen und Dokumente zu den ver-
schiedensten Themen zur Verfügung. Weiterhin gibt es auf der Waters-Webseite eine spezielle Rubrik 
‚Empower Tipp of the Week‘, die nützliche Informationen zu bestimmten Anwendungsfällen bietet und der 
Hersteller bemüht sich mit regelmäßigen Veranstaltungen, Empower 3 Themen zu besprechen. Viele Prä-
sentationen zur Software sind auch über eine Suchmaschine im Internet zu finden. Nicht zuletzt bietet die 
Software selbst eine umfangreiche Online Hilfe. 

Aber Eines wird dabei auch deutlich: Sich hier durchzuarbeiten ist mit erheblichem Zeitaufwand verbunden 
und erfordert Eigeninitiative. So fehlen meist die Ressourcen sich intensiv mit der Software auseinanderzu-
setzen und Empower-Anwender haben andere Prioritäten im Arbeitsalltag zu verfolgen. Da die Quellen 
vielfältig sind, wird man nie Gewissheit haben bereits alle Informationen zu einem Thema gefunden und 
bearbeitet zu haben. So erlangen viele Empower-Anwender ihr Wissen hauptsächlich über die Einarbeitung 
durch erfahrene Kollegen oder durch eigenes Ausprobieren im Arbeitsalltag. Ein systematisches und struk-
turiertes Heranführen an die Software bleibt meistens aus.

In meiner über 18 jährigen Zeit als unabhängiger Empower Berater erfahre ich daher regelmäßig den 
Wunsch nach einer zentralen und aktuellen Dokumentation. Diese sollte sowohl Empower Einsteigern einen 
schnellen Zugang zur Software ermöglichen, aber auch als leicht verständliches Nachschlagewerk zu den 
wesentlichen Themen des Laboralltags Hilfestellung bieten können. Wegen des fokussierten Einsatzes von 
Empower 3 im Pharmabereich, sollen dabei auch Fragestellungen zum Abbilden von Geschäftsprozessen 
behandelt werden , die über die eigentliche Funktionalität der Software hinausgehen. Zugegeben, kein ein-
facher Unterfangen.

Ein erstes Handbuch hatte ich bereits 2007 für meinen damaligen Arbeitgeber zusammengestellt, dabei 
konnte auch auf bereits vorhandene Dokumente aus anderer Feder zurückgegriffen werden. Dieses fand 
wenig Aufmerksamkeit, was sicher an einer unvorteilhaften Aufmachung, aber auch an dem fehlenden 
Vermarktungskonzept lag. 2015 erschien schließlich eine überarbeitete Version. Dafür habe ich sogar eine 
Ausbildung zum Grafikdesign und Textlayout wahrgenommen, um so auch direkten Einfluss auf die Gestal-
tung nehmen zu können. Und dieses Buch wurde dann wirklich ein unerwarteter und bahnbrechender Erfolg. 
Dabei hat es sich inhaltlich wenig von seinem Vorgänger unterschieden. Im gleichen Jahr folgte noch eine 
englischsprachige Version und noch heute werde ich regelmäßig bei meinen Kunden auf dieses Handbuch 
angesprochen. Zumindest im deutschsprachigen Raum scheint es sich zu einer Art Standardwerk zu Emp-
ower etabliert zu haben. Allerdings ist vielen nicht bewusst, wer der eigentliche Autor dieses Buches ist, da 
es unter der Marke meines damaligen Arbeitgebers vertrieben wurde. Mit meinem Ausscheiden verblieb das 
Buch auch dort, da ich versäumt hatte, mir die nötigen Rechte an dem Buch zu sichern, wurde seit dem aber 
auch nicht weiter aktualisiert und ist nun auch nicht mehr am Markt verfügbar.

Mittlerweile bin ich Inhaber meines eigenen Unternehmens und schaue nach 10 Jahren mit einem anderen 
Blick auf dieses Buch. Durch fortlaufenden Kundenkontakt, eigene Erfahrung und zeitintensive Recherchen 
sind mir viele Lücken und Ungenauigkeiten aufgefallen. Vieles würde ich heute so nicht mehr schreiben. 
Aber auch die Software selbst hat sich in 10 Jahren natürlich weiterentwickelt.
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Daher bestand schon lange der Wunsch nach einer Neuauflage, keine Ergänzung zum bestehenden, was 
auch rechtlich bedenklich wäre,  sondern eine wirkliche Neufassung. Im Sommer 2024 habe ich dann den 
Entschluss gefasst, loszulegen. Wie damals sollte alles wieder in Eigenregie ablaufen, von der Rohfassung 
bis zur fertigen Druckvorlage. Dieses Mal hatte ich aber viel mehr Zeit zur Verfügung, da eine Erstellung 
nicht nach Feierabend erfolgen musste.

Das Buch basiert auf keinem bestimmten Release Stand, sondern versucht die Release Stände Empower 
FR5 bis Empower 3.8 zusammenfassend darzustellen. Außerdem werden die Themen grundsätzlich unter 
der Annahme vorgestellt, dass Sie alle benötigten Berechtigungen besitzen. Es kann also durchaus sein, dass 
Ihnen Funktionen vorgestellt werden, die Sie mit Ihrer Berechtigungsstufe im eigenem System nicht ausfüh-
ren können. Weiterhin bauen die Kapital inhaltlich aufeinander auf. Auf die Erläuterung von Funktionen, die 
bereits zuvor beschrieben wurden, wird nicht erneut in der gleichen Detailtiefe eingegangen. Diese müssen 
dann als bekannt vorausgesetzt werden. Wo immer nötig, wird aber mit Verweisen gearbeitet. Bei der Dar-
stellung einzelner Abläufe wird auch weitestgehend auf Selbstverständlichkeiten verzichtet. Es wird also 
nicht jedes Mal erwähnt, dass man mit ‚OK‘ ein Objekt abspeichert oder mit ‚Next‘ das nächste Fenster im 
Wizard angezeigt wird. Dennoch habe ich Wert auf eine umfangreiche Bebilderung gelegt. Gerade das ist 
ein Grund, weswegen der Einsatz einer Online Hilfe in reiner Textform als schwierig angesehen wird. Mit 
Bildern können wir Zusammenhänge viel schneller und präziser erfassen.

Nun hoffe ich, dass mit diesem Buch ein Werk entstanden ist, das seinem Anspruch erfüllt. Bewusst soll 
es nun nicht nur Firmenkunden angeboten werden, sondern direkt über den Buchhandel auch privat erwor-
ben werden können, zu einem deutlich günstigeren Preis. Das Print on Demand Verfahren im Eigenverlag 
eröffnet dabei neue Möglichkeiten. So bietet es den Vorteil ohne große Investitionskosten auf einfache Weise 
aktualisierte Fassungen anzubieten. Mir ist bewusst, dass es auch weiterhin Wünsche geben wird, auf die 
dieses Buch nicht im erwarteten Umfang eingeht oder weitere Themen, die aktuell noch ausgeklammert 
werden. Dem möchte ich künftig bestmöglich nachkommen.

Spezielle Optionen wie Dissolution, Masspectrometry, GPC. CE werden in dieser Edition noch nicht 
berücksichtigt. Außerdem beschränkt sich die Darstellung auf das Pro Interface. Neben einer englischspra-
chigen Übersetzung sind aber auch Erweiterungen diesbezüglich geplant.

Mein Angebot an Sie soll daher auch als Bitte verstanden werden: Schreiben Sie mich für Fragen und 
Anregungen direkt an. Ich garantiere Ihnen eine Antwort, die Ihnen weiterhilft, und es wird auch 
uns helfen, dieses Werk weiterzuentwickeln. (info@cromingo.com)

Empower hat sich in den letzten Jahrzehnten dermaßen etabliert, dass es weltweit für Hunderttausende an 
Arbeitnehmern alltagsprägend geworden ist. So wie Microsoft Office Produkte am Computerarbeitsplatz, 
ist Empower zumindest im pharmazeutisch-analytischen Labor nicht mehr wegzudenken. Damit sehe ich es 
auch als gerechtfertigt an, frei von Herstellerinteressen Unterstützung anzubieten. Eine unabhängige Posi-
tionierung ermöglicht es auch, in anderer Form auf die Tücken der Software einzugehen und konstruktive 
Vorschläge zum Umgang mit diesen Tücken zu formulieren. 

Meine Erfahrung zeigt, dass ein solches Werk in Anwenderkreisen zu mehr Akzeptanz für die Empower 
Software führen kann. Man erfährt auch heutzutage immer noch eine gewisse Ablehnung des Systems, 
insbesondere bei Anwendern, die bereits mit anderen Systemen vertraut sind. Das ist meist dadurch zu erklä-
ren, dass Empower seiner eigenen, sehr individuellen Logik folgt und so nur schwer mit bereits bekannten 
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System verglichen werden kann. So wird der gedankliche Zugang zu Empower erschwert. Dennoch bestätigt 
sich wiederholt aufs Neue, dass die Möglichkeiten von Empower dankend angenommen werden, nachdem 
anfängliche Hürden im Verstehen der Software überwunden sind. 

Denn nicht zuletzt wegen seiner Einzigartigkeit ist es ein unvergleichbar starkes und mächtiges Pro-
gramm in der Welt der chromatographischen Datensysteme. Vollkommen zurecht konnte Empower 
daher seine Marktführerschaft, insbesondere im pharmazeutischen Sektor, in den letzten Jahrzehnten 
behaupten.

Bedanken möchte ich mich ausdrücklich bei Dr. Britta Kupfer, die mit vielen Anregungen, einen differen-
zierten Blick auf die Thematik und einer peniblen Durchsicht der einzelnen Kapitel einen wertvollen Beitrag 
zum Gelingen dieses Buches geleistet hat.

Lassen Sie uns nun gemeinsam mit diesem Buch auf die Reise begeben, um die Empower 3 Welt zu erkun-
den und besser zu verstehen.

									         Ingo Green

Hinweis: In diesem Buch wird durchgehend das generische Maskulinum verwendet, um einen 
leichten Lesefluss zu ermöglichen. Damit dürfen sich aber Leserinnen und Leser in gleicher Weise 
angesprochen fühlen.
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4.3.	 Einsatz der Review Funktion
Um nun einen Blick auf die erzeugten Chromatogramme werfen zu können, laden Sie das Sample Set in die 

Review Ansicht (‚rechte Maustaste > Review‘ oder Direktauswahl über ‚Review‘ Taste im Menüband).

Das Review Fenster lässt sich grund-
sätzlich über die Tabellenansichten 
‚Sample Sets‘, ‚Injections‘ und ‚Chan-
nels‘ für nicht ausgewertete Daten 
aufrufen und über die Ansichten ‚Result 
Sets‘ und ‚Results‘ für bereits erzeugte 
Ergebnisse. Ein Sonderfall bildet noch 
der Aufruf von Review im Run Sam-
ples Fenster. Auf die Unterschiede und 
welche Vor- und Nachteile sich jeweils 
ergeben wird im Abschnitt „7.2. Review 
Ansichten (Sample Sets, Injections, 
Channels, Result Set, Results)“ auf Seite 
87 näher eingegangen.

Die Review Funktion wird auch benötigt, um einen Abgleich mit einer bereits bestehenden Processing 
Method vorzunehmen oder eine neue Processing Method zu erstellen.

Tragen Sie dafür Sorge, dass gleich zu Beginn, also beim Öffnen des Review Fensters, eine passende 
Processing Method geladen wird. Sie können eine Methode aktiv in die Review Ansicht laden, es 
gibt aber auch Möglichkeiten, dies zu automatisieren. Dazu später mehr.

Zunächst lassen Sie uns ein Beispiel durchspielen, 
bei dem bereits eine passende Methode vorliegt und 
diese nicht weiter bearbeitet werden braucht. Wählen 
Sie über ‚File > Open > Processing Method‘ die benö-
tigte Methode aus.

In unserem Fall wählen wir ‚LC PQ‘ aus. Über 
‚Open‘ wird die Methode in die Review Ansicht 
geladen.

Sie können jederzeit über die Anzeige unten rechts 
im Fenster kontrollieren, welche Methode gerade im 
Hintergrund geladen ist. ‚Untitled‘ oder ‚Unbenannt‘ 
bedeutet letztlich ‚keine Methode‘, und es kann metho-
denunabhängig mit Standardwerten gearbeitet werden.Le
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4.3.1.	 Übersicht Review Main View (Aufruf über Tabelle ‚Sample Sets‘)

» Öffnen Sie die Review Maske erstmalig, dann werden Sie feststellen, dass die einzelnen Ele-
mente anfänglich etwas ungünstig
angeordnet sind. Dies können Sie an
Ihre Bedürfnisse anpassen, z.B. wie
folgt:

» Wählen Sie ‚View > 2D Layout‘ aus
» Blenden Sie all 3D Elemente und

das Annotation Tool aus, indem Sie
mehrfach ‚View > Toolbar‘ aufrufen
und die Elemente ‚3D‘, ‚Plot Annota-
tion‘, ‚Extract‘ und ‚Spectrum Index‘
abwählen.

» Speichern Sie die getroffenen Einstellungen über ‚File > Save Preferences‘, um sicherzustellen,
dass Sie beim nächsten Mal eine vorteilhaftere Ansicht erhalten.

Hinweis: Gerade Einsteigern kann die Orientierung in Empower große Schwierigkeiten bereiten. Viele 
unterschiedliche Fenster, viele oft ungünstig angeordnete Schaltflächen und Tabellen erschweren 
die Orientierung. Gewöhnen Sie sich daher an, die Fenster ein wenig aufzuräumen und nach Ihren 
Bedürfnissen zu gestalten, bevor Sie mit der eigentlichen Arbeit beginnen. Ihre individualisierten 
Einstellungen können Sie regelmäßig im Benutzerprofil abzuspeichern. In einem geordnetem Fens-
ter wird man deutlich leichter und zielgerichteter arbeiten können.

Die Darstellung im Review sollte nun wie in der nächsten Abbildung dargestellt aussehen.
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Manuelle Nachbearbeitung ist im oberen Chromatogramm klar über die Basislinien Codes zu erkennen 
(Kleinbuchstaben beim Basislinienstart).

Und allein über die visuelle Überprüfung der unterschiedlichen Versionen des integrierten Chroma-
togramms, kann überhaupt die Zulässigkeit des nachträglichen Eingriffs bewertet werden. Die alleinige 
Betrachtung von definierten Integrationsvorgaben hilft hier nicht weiter.

Zur weiteren Aufklärung hilft ein Blick über den Tellerrand. Denn es gibt CDS-Systeme, bei denen 
nicht jede einmal erzeugte Version eines integrierten Chromatogramms direkt abrufbar vorliegt und damit 
unterschiedliche Versionsstände direkt visuell miteinander verglichen werden können. Lediglich der Ver-
änderungsverlauf wird in der Historie aufgezeichnet. Konkret wird dem nachbearbeiteten Chromatogramm 
dann z.B. eine abgewandelte Version der ursprünglichen Integrationsmethode zugewiesen.

In diesem Fall muss natürlich die Peakintegration in einer Form beschrieben sein, dass jederzeit aus dem 
Rohdatenchannel die resultierende Integration des Chromatogramms abgerufen bzw. präzise reproduziert 
werden kann.

In diesem Zusammenhang ist die eingangs beschriebene Anforderung dann auch unerlässlich und es ist 
davon auszugehen, dass besagte CDS-Anwender in der Vergangenheit mit einem System gearbeitet hatten, 
wo diese Anforderung so umzusetzen ist.

Man kann also von einer Anforderung sprechen, die sich aus der eigentlichen Kernanforderung, wie in 
ICH M10 beschrieben, ableitet, aber letztlich nur auf die technische Umsetzung des Audit Trails in der ver-
wendeten Software bezieht. Da es sich aber nur um eine abgeleitete Anforderung handelt, kann diese so nicht 
einfach auf andere Systeme wie Empower übertragen werden, da hier die Kernanforderung durch andere 
technische Möglichkeiten bereits erfüllt ist.

[1] „Can We Continue to Draw the Line?“, H. Longden, R.D. McDowall, LCGC Ausgabe vom Dezember 
2019
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7.	 Betrachten und Vergleichen von 
Chromatogrammen

7.1.	 Die Overlay Funktion
Im Review Fenster können Chromatogramme aus unterschiedlichen Injektionen auch übereinandergelegt 

werden. Bedingung hierfür ist, dass das Review entweder über den Tabellenreiter ‚Channels‘ oder ‚Results‘ 
aufgerufen wird. Gehen Sie wie folgt vor:

	» Wir wählen für unser Beispiel zunächst die Ansicht ‚Result Sets‘ aus.
	» Wir wählen dann die beiden Result Sets aus, welche die Ergebnisse enthalten, die wir verglei-

chen möchten.
	» Wir rufen für diese Result Sets den Befehl ‚View As > Results‘ auf. Die Ansicht wechselt über 

auf den Tabellenreiter ‚Results‘.
	» Wir klicken auf den Spaltenkopf für die Spalte ‚Vial‘, um die Einträge nach Vial Position zu 

sortieren.
	» Wir wählen alle Einträge einer Positionsnummer aus, in unserem Beispiel Position 1.

	» Wir rufen für die Auswahl den Befehl ‚Review‘ auf. Es öffnet sich das Review Fenster.
	» Wir wählen unter dem Chromatogramm die Tabelle ‚Channels‘ aus und aktivieren die Overlay 

Ansicht über die kleine Schaltfläche oben links über dem Chromatogramm.
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8. Roter Faden
Lassen Sie uns den bisherigen Ablauf einmal illustrativ in einem Diagramm darstellen. Damit kann Ihnen 

einen roten Faden an die Hand gegeben werden. Die einzelnen Aktionen sind in der entsprechenden Reihen-
folge entlang des roten Fadens abzuarbeiten. Die Spalten zeigen auf, in welchem Anwendungsfenster die 
jeweilige Aktion abzulaufen hat. Eine farbliche Kennzeichnung einer Zelle bedeutet, dass das entsprechende 
Anwendungsfenster geöffnet ist.

Aktion Project Run 
Samples

Alter 
Samples

Compo-
nent Editor

Review Preview/
Publisher

Instrument Method erstellen

Sample Set erstellen. 

Standard-Einwaagen eintragen

Sample Set starten 

Sample Set bearbeiten 

Chromatogramme ansehen

Processing Method abgleichen

Sample Set prozessieren

Result Set prüfen

Result Set manuell 

nachintegrieren

Result Set reprozessieren

Result Set berichten 
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Feld Erläuterung

CCompRef1, CCom-
pRef2, CCompRef3

Angabe einer Bezugskomponente, die als Variable in Custom Field Formeln für Inter-
peak Berechnungen verwendet wird. Im Gegensatz zur globalen Variable ‚CCalRef1‘ 
können diese Referenzen komponentenbezogen eingesetzt werden.

CConst1 bis CConst7 Angabe einer komponentenbezogenen Konstante, die als Variable bei peakgebunde-
nen Custom Field Berechnungen verwendet wird.

10.4.	 Reiter: Impurity
Einstellungen zur Berechnung von Verunreinigungen werden in der Processing Method beim Reiter ‘Impu-

rity‘ getätigt. Lassen Sie mich zunächst die Funktionen im Detail vorstellen. 

1.	 Impurity Response: Auswahl der Bezugsgröße
2.	 Auswahl einer Hauptkomponente
3.	 ICH Thresholds: Definition von globalen Grenzwerten
4.	 Auswahl von ‚Component Types‘, die bei der Berechnung des Wertes ‚Adjusted Total Area‘ 

nicht berücksichtigt werden sollen
5.	 Impurity Groups: Definition von selbst gewählten Peakgruppen
6.	 Specified Impurities: Auswahl von Komponenten, für die spezifische Grenzwerte gelten sollen.

Die Funktionen werden im Folgenden im Detail beschrieben.

Impurity Response

Im Feld ‚Impurity Response‘ (1) kann die Peakkennzahl angegeben werden, auf deren Grundlage eine Aus-
wertung erfolgen soll. Hier stehen standardmäßig folgende Größen zur Auswahl:
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